PCC MIX DESIGN SOFTWARE TUTORIAL Version 2.4

PCC M |X DESIGN For help, comments, and/or suggestions, please contact:
J M. Krstulovich, Jr.
SOFTWARE TUTORIAL Igcn)“TasBurearuscl)an/;eria:s and Physical Research

126 East Ash Street
Springfield, lllinois 62704
Phone: (217) 782-7200

(Version 2.4) email. DOT.PCCMIX@illinois.gov

11 IMPORTANT ! This spreadsheet utilizes macros. Depending on Excel’s security settings, the macros may
not be enabled. To change the macros settings for Excel, refer to the steps found at the end of this tutorial.

General
This spreadsheet is designed to calculate and report PCC mix designs for submittal to IDOT. The spreadsheet is
comprised of data inputs based on the mix design methodology provided in the PCC Level lll Technician course
manual.

Buttons are provided for ease of navigation, and their use is recommended as they ensure proper operation
throughout the design process. Using the worksheet tabs, found at the bottom of the Excel screen, will also work.

The blue-shaded areas are cells which require data input, green-shaded areas are optional (unless required by
your District), and white cells are calculation fields, which are password protected from accidental overwriting.

Throughout the spreadsheet, comments have been interspersed to offer hints on where to find relevant
information. To view comments, hold the cursor over the red tags found in the upper right hand corner of
commented cells, as shown below. These comments generally refer to sections of the Course Manual; however,
it should be noted that the Department’s Standard Specifications and Special Provisions take precedence.

START. Select Units of
_||"® EnGLISH (C) METRIC
Measure:
Step 1 Mix Design No p'IContractor/Producer designated mix design number.
IDOT Design No. N|This is NOT the IDOT mix design number (below),
which wil be assigned by the District upon approval
Date Created Miof the mix design.
g
Concrete Code | 21605 - PCC Cement & Fly Ash v

Figure 1. Example of a comment; note red flag, which indicates the cell has a comment.

Tutorial Mix Design

This tutorial also includes notes for how to input the example mix design discussed in Section 2.9 of the Course
Manual. If you follow the notes in order as they are presented herein, you should successfully create a basic
PCC paving mix design while also being introduced to many of the spreadsheet’s functions and capabilities.
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PCC MIX DESIGN SOFTWARE TUTORIAL

Version 2.4

Step 1. _Design Information

The Design Information worksheet is important to establish the who-what-where of the mix design. This is where
the designer decides in which units of measure the mix will be designed, what type of concrete it is, for what
Classes of concrete it is valid, and those responsible for the mix design.

START.

Step 1.

FIT TO SCREEN

} Version 2.4

Select Units of [ = o ||| ) METRIC
Measure:

Mix Design No. pmc0001pv
IDOT Design No. Not yet assigned
Date Created mo | ¥ |day | ¥ |year | ¥
Concrete Code | 21605 - PCC Cement & Fly Ash v
Class (select up to 5)
‘ ¥ Pv-Pavement ‘ ‘ [~ BS-Bridge Super ‘ [~ sI-Structures ‘

‘ [ PP-Patching

‘ ‘F DS-Driled Shaft ‘ ‘F PC-Precast

‘ [~ RR-Rairoad

‘ ‘ [~ sC-Seal Coat

‘ ‘ [~ PS-Prestressed

IMPORTANT: All worksheets are password protected.
Cells highlighted BLUE or GREEN can accept data input.

BLUE cells are mandatory; GREEN cells are optional.

Step 2.
Enter Design Variables

View Design Report
(English units)

Enter IDOT
Engineers helow...

Enockson

Jones

Au

View Design Report

Responsible Location

91 - District 1 v

Lab Type

PP - Producer Plant Site Lab 4

(metric units)
Step 3.
Enter Aggregate
Information View MISTIC Report
Step 4.

Enter Finely Divided
Minerals & Admixtures

Company Name:
Location:

Pave Masters Co.

Chicago

Designer

Phone:
‘| jsmith@email.com

email

Name:

Smith

555-555-5555

Mix Producer No.
Name:

1234-05

Everyman Redi-Mix Co.

IDOT Engineer

Enockson v

Contract No. (optional)

Il i
() g Departyen

For help, comments, and/or suggestions,

please contact:

James Krstulovich, P.E.

Bureau of Materials & Physical Research

Phone: (217) 782-7200

email: DOT.PCCMIX@Illinois.qov

Fit to Screen [button]:

English/Metric [toggle]:

Toggle button for selecting the units of measure for the mix design’s inputs.

Click this button to optimize each page of the mix design spreadsheet for viewing on your
screen.

All data

inputs will have to be entered in the chosen units of measure. However, the design will
be reported in both units of measure on the different final mix design reports generated.

EXAMPLE | Assuming most of us are more comfortable using English units of measure (Ibs,
PROBLEM | yd®, etc.), the example mix design will be designed using English units.
Click on the ENGLISH toggle button.

Mix Design No.: Alphanumeric designation (up to nine characters in length). This is the Producer’s or
Contractor's self-designated mix design number; this is not the mix design number
assigned by IDOT, see “IDOT Mix Design No.” below.

EXAMPLE | Because this is the Producer’s or Contractor's mix design number, any reasonably

PROBLEM | succinct and unique identifier can be used here, as long as it is no more than nine
characters long. For this example, we will use PMCO0001PV (i.e., Pave Masters Co.
paving mix #1).

IDOT Mix Design No.: Nine character alphanumeric mix design number reported to the Department’s MISTIC
database. This number will be assigned by your District to an approved mix design.

EXAMPLE | Because this mix design number is assigned by the District upon approval, this cell
PROBLEM | reads Not yet assigned.

Date Created:

The date the mix design was created.
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PCC MIX DESIGN SOFTWARE TUTORIAL Version 2.4

Step 1. Design Information (continued)

Concrete Code:

Select the appropriate material code. This code is used by the Department’'s MISTIC
database to designate the type of concrete.

EXAMPLE

Because this mix will utilize Type | portland cement and Class C fly ash, the
PROBLEM | appropriate Concrete Code to select from the drop-down list is 21605.

Class:

Select up to five Classes of concrete.

EXAMPLE

Because this mix will be used for a continuously reinforced portland cement
PROBLEM | concrete pavement, the appropriate Class to select is PV.

Responsible Location:

District responsible for mix design's use; for example, “91” for District 1.

EXAMPLE | Select one of the nine IDOT Districts with which you typically work; for example,
PROBLEM | select 91 if you often work with District 1 in the Chicago area.

Lab:

Company Name:

Location:

Designer:

Mix Design Producer:

IDOT Engineer:

Contract No.:

Laboratory associated with the creation and/or testing of the design. For example: DI for
district mix designs, or PP for producer mix designs. Contractors and Producers are to
use "Producer" Lab codes. Consultants are to use "Independent” Lab codes.

Name of laboratory responsible for creation and/or testing of mix design.

Nearest municipality to Lab/Company.

Name, phone number, and email of person that created the design.

MISTIC producer number and name of producer.

This is the IDOT District representative to whom this mix design should be submitted for
approval. Consult your District's Mixtures Control Engineer for more information. Use

the yellow table to the right of the main input area to add names to the drop-down list.

(Optional) Either the five digit contract number, or if it is a local agency contract without a
five digit number, then enter the MFT (Motor Fuel Tax) contract number.
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PCC MIX DESIGN SOFTWARE TUTORIAL

Version 2.4

Step 2. Design Variables

The Design Variables worksheet is where the designer first begins to determine the mix design’s parameters that
factor into the mix design’s proportion calculations.

FIT TO SCREEN |
2. Design Variables _— Return to Start.
Batch Size 1.00 cubic yard bt Design Information
Cement Factor 9.65 cwt / cu yd Initial: 5.65 cwt / cu yd
Mortar Factor 0.83 Typically between 0.70 - 1.00 mﬁﬁiﬂonf 0.30 cwt / cu yd
Target Air Content| 65  |% Gl e owt/ cu yd Step 3.
Target Slump 1.50 in. Final:l 5.35 |cwt/cuyd SR damnas U
Step 4.
Enter Finely Divided
Mlns_rals & A_dmixturaq ]
Determine Water Content: |[@ a. standard Method]| [ 5. wic Ratio Method| Typical FA Water Requirements
FA Type‘ "B" Combination of rounded and angular paniclﬁg Type A 5.1 galicwt
FA Water Req. 23 |galicwt Type B 5.3 galicwt View Design Report
CA Water Req. 0 gal/owt Type C 55  galiewt (Engitsh units)
Water Reduction 6.0 % Water Adjustment Help | Typical CA Water Requirements View Design Report
- - tric units
Fineness Mod (optional) Cr. Stone 02  galicwt (metrio umte)
Admixture W - Water Reducer | W Slag 0.4 galicwt View MISTIC Report
Fly Ash Class c > | Gravel 0.0 gallcwt
Batch Size: Batch size in cubic yards (cubic meters). All mix designs are created per 1 yd3 (1 m3).

Cement Factor:

Cement quantity in hundredweight per cubic yard (kilograms per cubic meter).
Adjustments based on admixture use or underwater placement can be applied using the

Cement Factor Adjustment table.

EXAMPLE
PROBLEM

From Table 2.2.1 in the Course Manual, the cement factor for Class PV concrete
from a central mixed plant is 5.65 cwtlyds.

Also, from Section 2.2.2, a cement factor reduction of 0.30 cwt/yd3 can be applied
because a water-reducing admixture will be used. Enter 0.30 in the appropriate box
of the Cement Factor Adjustment table.

Thus, the final, adjusted cement factor is reduced to 5.35 cwtlyd’.

Mortar Factor:

Refer to Table 2.8.2.3 Design Mortar Factor in the Course Manual.

EXAMPLE
PROBLEM

From Table 2.8.2.3 in the Course Manual, a mortar factor can be selected for Class
PV concrete.

Enter 0.83 as a reasonable starting point.

Target Air Content:

Percentage of entrained air in the concrete to improve durability. Refer to Table 2.7.1 Air

Content in the Course Manual.

EXAMPLE | From Table 2.7.1 in the Course Manual, the midpoint of the air content range for
PROBLEM | Class PV concrete is 6.5%.

Target Slump: Enter the target slump in inches (mm). Refer to Table 6.1 Slump in the Course Manual.
EXAMPLE | From Table 6.1 in the Course Manual, the slump range for Class PV concrete is 2 to
PROBLEM | 4 inches, except when slipformed, it is 1/2 to 2 1/2 inches (Table 6.1, Note 1). As

noted in Section 6.1, experience has shown that a slump of 1/2 to 1-1/2 inches at
the paver is typical for slipformed pavement construction, but many Contractors
desire 1-1/2 inches to obtain a smooth pavement. Enter 1.5 inches.
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PCC MIX DESIGN SOFTWARE TUTORIAL Version 2.4

Step 2. Design Variables (continued)

Determine Water Content
First, using the toggle switch, select either the Standard Method or the w/c Ratio Method.

The Standard method requires the designer to enter fine and coarse aggregate water requirements, as well as
percent water reduction. Refer to Section 2.5.1 Water Requirement in the Course Manual for more information.

Alternatively, the w/c Ratio Method will determine mix water based on the water/cement ratio (w/c) entered and
the total content of cement and finely divided minerals. No water adjustment needs to be entered as it will be
back-calculated based on the w/c ratio and aggregate water requirement inputs.

If the Standard Method has been selected, refer to the following inputs:

Determine Water Content: |@ a. standard Method|| |[( B. w/c Ratio Method Typical FA Water Requirements
FA Type| "s" combination of rounded and angular palticlesE] Type A 5.1 gallcwt
FA Water Req. 53 gal/cwt Type B 53 gal/cwt
CA Water Req. 0 gal/cwt Type C 5.5 gal/cwt
Water Reduction 6.0 % Water Adjustment Help Typical CA Water Requirements
Fineness Mod (optional) Cr. Stone 0.2 gallcwt
Admixture W - Water Reducer \Z‘ Slag 0.4 galicwt
Fly Ash Class c ‘ v | Gravel 0.0 gal/cwt

FA Type: Select fine aggregate type.

EXAMPLE Because this mix will utilize a Type “B” fine aggregate, select B from the
PROBLEM drop-down list.

FA Water Req.. Water requirement for fine aggregate in gallons per hundredweight (liters per kilogram) of
cement and finely divided minerals. This value is based on the type of fine aggregate. For example, 5.1 gal/cwt
(0.426 L/kg) is typical for Type “A” fine aggregate, as shown in the table, Typical FA Water Requirements.

EXAMPLE Because this mix will utilize a Type “B” fine aggregate, the typical water
PROBLEM requirement is 5.3 gal/cwt.

CA Water Req.: Water requirement for coarse aggregate in gallons per hundredweight (liters per kilogram) of
cement and finely divided minerals material. This value is based on the type of coarse aggregate. Typical
values are provided in the table, Typical CA Water Requirements.

EXAMPLE Because this mix will utilize a non-crushed gravel coarse aggregate, the
PROBLEM typical water requirement is 0.0 gal/cwt.

Water Reduction: Percentage of water adjustment (typically a reduction) taking into account various factors,
such as admixture use, cement and finely divided mineral content, air content, etc. Note that because this input
is referred to as a “reduction”, the value entered may seem counter-intuitive; that is, a water reduction should be
entered as a positive value, while a water addition should be entered as a negative value. For example, enter
“10.0" for a 10 percent water reduction, and enter “-10.0” for a 10 percent water addition.

For help determining a reasonable water adjustment, click on the button, Water Adjustment Help. The Water
Adjustment Help tab is modeled after Table 2.5.2 Adjustment to Basic Water Requirement in the Course
Manual.

EXAMPLE Because this mix will utilize a water-reducing admixture to provide a target
PROBLEM water reduction of 6%, enter 6.0.

Note: If for some reason this mix needed a 6 percent water addition, you
would have entered -6.0.
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Step 2. Design Variables (continued)

If the W/C Ratio Method has been selected:

Determine Water Content: |f‘ A. Standard Method" ® B. w/c Ratio Method

Enter W/C Ratio > 042

Select FA Ty pe > "B" Combination of rounded and angular par‘ticlesB

CA Water Req. > 0
ignhore >>> Water Adjustment Help

Enter W/C Ratio: When w/c Ratio Method is toggled, this field appears. Enter the target water/cement ratio that
the design water will be based on; for example, 0.42.

It is still important to select the appropriate FA Type, as well enter the CA Water Requirement, so as to allow the
spreadsheet to back-calculate the water reduction on the final mix design reports.

EXAMPLE Another way to determine mix water is based on inputting a target
PROBLEM water/cement ratio (w/c):

In this example, per Table 2.6.1 in the Course Manual, the maximum wi/c
for Class PV concrete is 0.42.

Also, by selecting the appropriate fine aggregate type (“B”) and entering a
reasonable water requirement for the coarse aggregate, the water
reduction will be back-calculated on the final mix design reports.

Fineness Mod:

(Optional) Fineness modulus of the fine aggregate used in the mix design; for example,
2.36. Fineness modulus is for informational purposes only; fineness modulus does not
factor into proportioning calculations.

Admixture: Choose an admixture type: “W — water reducer”, “S — superplasticizer”, or “R — retarder”.
EXAMPLE | Because this mix will utilize a water-reducing admixture to meet the water/cement
PROBLEM | ratio requirement, select W — Water Reducer from the drop-down list.

Fly Ash Class: Choose the class of fly ash used in the mix design, if applicable.

EXAMPLE | Because this mix will utilize Class C fly ash, select C from the drop-down list. If this
PROBLEM | example did not utilize any fly ash, you would select “n/a”.
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Step 3. Aggregate Information
The Aggregate Information worksheet is where the designer enters all fine and coarse aggregate information.

Note that although up to six aggregate materials can be accommodated by this spreadsheet, the Department’s
MISTIC database only allows a total of six materials, including cement and finely divided minerals. For example,
four aggregates, one cement, and one finely divided mineral (e.g., fly ash); or three aggregates, one cement, and
two finely divided minerals (e.g., fly ash and microsilica).

FIT TO SCREEN |
3. Aggregate Information
Material |Producer| Ledge Producer SSD Sp. % Moisture Return to Start.
Code | Number | Number Name Gravity | Blend (%) Design Information
1/027fa01 54321-01 Little Rocks Co. 2660 100.0 Return to Step 2.
2[020ca07 12345-05 Big Rock Co. 2.680 100.0 PEEDVAER
3 Step 4.
Enter Finely Divided Minerals
4 &
5 Admixtures Info
6
View Report (English) |
View Report (metric)
View MISTIC Report |
3a. Voids in Coarse Aggregate ’ || () Calculated || || (@) User-Defined ||
Refer to lllinois Test Procedure 306 User-defined: Enter voids, V =<<<
Coarse QOven-Dry
Aggregate %Absorption‘ Sp. Gravity Calculated:
Net Weight of Aggregate Ib. Volume of Voids per Unit Volume of - see
Volume of Measure cu. ft Oven-Dry Rodded Coarse Aggregate above
$SD Sp.G Calibration of Measure:
% Absorption % Weight of Water to fill Measure Ib.
Oven-Dry Sp. G Temperature of Water F
Unit Weight Ibicu. ft Calibrated Volume of Measure cu. ft

Material:

Aggregate material codes.

Coarse and fine aggregates may be entered in any order,

except as required by your District. For more information regarding aggregate material
codes, refer to form BMPR MI504 “Field/Lab Gradations”.

EXAMPLE
PROBLEM

¢ Fine aggregate: Enter 027FA01 as given in the Course Manual. This material
code is for an “A” quality natural sand meeting the gradation criteria for FA 1
per Article 1003.01(c).

o Coarse aggregate: Enter 020CA07 as given in the Course Manual. This
material code is for an “A” quality non-crushed gravel meeting the gradation
criteria for CA 7 per Article 1004.01(c).

Producer Number:

Producer Name:

Specific Gravity:

Aggregate producer name.

Aggregate producer number. This field is required for all aggregate components.

Saturated Surface Dry (SSD) specific gravity of each aggregate.

EXAMPLE
PROBLEM

The example problem as given in the Course Manual indicates that the saturated
surface-dry specific gravities for the fine and coarse aggregate components are
2.66 and 2.68, respectively.
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PCC MIX DESIGN SOFTWARE TUTORIAL Version 2.4

Step 3. Aggregate Information (continued)

Agg. Moisture (%): Moisture of aggregates relative to SSD condition. If the percentage moisture is drier than
SSD, it must be entered using a negative value (e.g., -1.00).

EXAMPLE | No aggregate moisture is indicated in the example problem as given in the Course
PROBLEM | Manual. Thus, it can be left blank.

% Blend: Percent blend for aggregate components. If only using one coarse aggregate and one
fine aggregate material, enter “100” for each. On the other hand, if blending coarse
aggregate materials, say, CA 11 and CA 16 at 75 and 25 percent, respectively, enter a
"75" for the CA 11 and a "25" for the CA 16. Similarly, if blending fine aggregate
materials. Do not blend coarse and fine aggregate, except as noted below for CAM II:

Note for CAM Il designs only—Recommended % Blend of coarse-to-fine aggregate:
50-50 when using CA 7, CA 9, or CA 11; 75-25 when using CA 6; and 100-0 (i.e. no fine
aggregate) when using CA 10. For example, when using CA 6 and FA 1, enter “75” for
the CA 6 and “25” for the FA 1.

EXAMPLE | Because this mix is utilizing one coarse aggregate component and one fine
PROBLEM | aggregate component (and the mix is not CAM Il), enter 100 for coarse aggregate
and 100 for fine aggregate, as well.

Step 3a. Voids in Coarse Aggregate

The Designer has the option to either enter the Voids directly or calculate Voids by performing ITP 306, Voids
Test of Coarse Aggregate for Concrete Mixtures, which can be found in the Manual of Test Procedures for
Materials. However, some Districts may provide a value for general aggregate types, such as “0.36” for gravels.

If calculating the Voids, enter the “% Absorption”, “Net Weight of Aggregate”, and “Volume of Measure” as
determined while performing ITP 306. Consult your District for “% Absorption” values. (The Calibration of
Measure is not required for every mix design, but is included for convenience.)

3a. Voids in Coarse Aggregate ) “ ™ Calculated || " ) User-Defined “
Refer to lllinois Test Procedure 306 [ J<ignore
Coarse Oven-Dry
Adgregate o, Absorption SP- Gravity Calculated:
Net Weight of Aggregate 53.00 Ib. Volume of Voids per Unit Volume of V=037
020CA07 -0.5 2.69 Volume of Measure 0.500 cu. ft Oven-Dry Rodded Coarse Aggregate
$SD Sp.G 2.68 Calibration of Measure:
% Absorption -0.5 % Weight of Water to fill Measure| 31 [Ib.
Oven-Dry Sp.G 2.69 of Water| 72 |F
UnitWeight] 106.00 [Iblcu. ft Calibrated Volume of Measure| 0.5  |cu.ft

If entering the Voids directly, toggle the “Enter Directly” button and input the appropriate value in the “User-
defined” box. Important: Enter “1.00” for any mix design that does not contain coarse aggregate.

User-defined: Enter voids, V = <<<

Calculated:
Volume of Voids per Unit Volume of _ see
Oven-Dry Rodded Coarse Aggregate above

Calibration of Measure:

Weight of Water to fill Measure Ib.
Temperature of Water F
Calibrated Volume of Measure cu. ft

EXAMPLE | The example problem as given in the Course Manual notes that the Voids for the
PROBLEM | coarse aggregate is 0.37.
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Step 4. Finely Divided Minerals & Admixtures Information

This worksheet is where the designer enters all information pertaining to cement and finely divided minerals, as
well as chemical admixtures (e.g. air-entraining water-reducing admixtures, etc.).

FIT TO SCREEN |
4. Cement and Finely Divided Minerals Information )
Material Producer Producer Specific | Percent | Replacement Return to Start.
Code Number Name Gravity | Blend | Ratio | Design Information
1| 37601 Type I, Portland v 3.150 75.0 Returnto Step 2.
2| 37801 Fly Ash Cass € ¥ 555-05 |City Electric Co. 2610 | 25.0 pesign Variables
3| Select Slag.. h Return to Step 3.
4| Select Other FDM... v 2ggiegatelinfoppation
100%
5. Admixture Information Report (English) |
Material Admixture Type Product Remarks Report (metric) |
Code (ASTM C 494) Name (e.0. dosage rate) MISTIC Report |
1| 42000 | AEA - Air Entraining | v |Air Plus X
2| 43000  A- water Reducer '~ Water Reducto 2000
3 n/a >
4 nfa v
Latex Admixture Information
6. General Remarks Batch Dosage gal/cu yd

1 ASR Mix Option 2, 25% fly ash

2

Specific Gravity

% Solids

%

Material:

Cement and finely divided mineral (FDM) material codes.

Each line is dedicated to a

specific material: Line 1 for cement, Line 2 for fly ash, Line 3 for GGBF slag, and Line 4
for miscellaneous (e.g., microsilica, high-reactivity metakaolin, etc.).

EXAMPLE
PROBLEM

Because this mix will utilize a Type | cement and Class C fly ash, Lines 1 and 2 will

be used.

e Cement: Because this mix is utilizing a Type | cement, select 37601 Type |,

Portland from the drop-down list.

e Fly ash: Because this mix is utilizing a Class C fly ash, select 37801 Fly Ash

Class C from

the drop-down list.

Producer Number:

Producer Name:

Specific Gravity:

Material producer number. This field is required for all finely divided minerals.

Material producer name.

Specific gravity of each material. The specific gravity of cement is normally assumed to
be 3.15. However, for a blended cement, this value should be verified with the District.
Specific gravity values for finely divided minerals can be obtained from the Approved List

of Suppliers for Finely Divided Minerals.

EXAMPLE
PROBLEM

The example problem as given in the Course Manual notes that the specific gravity

for the fly ash component is 2.61.

Although no specific gravity is given for the cement component, from Section 2.3 in
the Course Manual, the specific gravity of cement is normally assumed to be 3.15.
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Step 4. Finely Divided Minerals & Admixtures Information (continued)

Percent Blend: The blend percentage must be entered for each material, totaling 100. For example,
when blending fly ash and cement at 20 and 80 percent, respectively, enter a "20" for the
fly ash and an "80" for the cement.

EXAMPLE | First, we have to determine if we need to mitigate for alkali-silica reaction (ASR):
PROBLEM
From Section 2.4.3 in the Course Manual, it is determined that the component
aggregates are Group Il (fine aggregate expansion in the >0.16% - 0.27%
range and coarse aggregate expansion £0.16%). Thus, we are required to use
Mix Option 1, 2, 3, 4, or 5.

Because the example problem as given notes that the mix will utilize a cement
with alkali content >0.60% and a Class C fly ash, we will use Mix Option 2.

Mix Option 2 requires a minimum 25.0 percent Class C fly ash.

Furthermore, from Section 2.4.1.1 in the Course Manual, the Class C fly ash
component can replace up to 30 percent of the cement.

Thus, it is decided to use 30 percent fly ash since fly ash is cheaper than cement,
and will provide the most economical mix.

Because the total Percent Blend must equal 100, enter 70.0 for the cement and
30.0 for the fly ash.

Replacement Ratio: (Optional) Enter the replacement ratio for each finely divided mineral, if applicable. If left
blank, the default value of “1.00” will be used.

Step 5. Admixtures Information

Material Code: Enter admixture material codes here. The 5-digit material code for admixtures can be
found on the Approved List of Concrete Admixtures.

Admixture Type: Choose admixture type.
Admixture Name: Enter admixture product name here.
Remarks: Enter key information regarding proposed dosage rates, dosing procedures, etc.

Step 6. General Mixture Remarks

Remarks: Enter any pertinent information not already covered. When required to mitigate for alkali-
silica reaction (ASR), indicate the mixture option selected.

EXAMPLE | Because we are required to mitigate for alkali-silica reaction, we must indicate the
PROBLEM | mixture option selected.

Enter ASR Mix Option 2, 30% fly ash.

Latex Admixture Information (only required for mix designs using a latex admixture)

Batch Dosage: Enter latex admixture dosage in terms of gallons per cubic yard (liters per cubic meter).
Specific Gravity: Enter manufacturer’s specific gravity for the latex admixture.
% Solids: Enter manufacturer’s percent solids for the latex admixture.

HARD COPIES UNCONTROLLED Page 10 of 14



PCC MIX DESIGN SOFTWARE TUTORIAL

Version 2.4

Design Report

Given the inputs, the mix design proportions are calculated and reported. Three design reports are generated:
one in English units of measure, one in metric (Sl), and one formatted per the Department’s MISTIC database
requirements. Please consult your District for which report(s) to submit for approval.

ENGLISH UNITS DESIGN REPORT

DTT03710 PCC MIX DESIGN Version 2.4
IDOT MIX # Not Assigned MATERIAL 21605 CONCRETE PC FLYASH EFFECTIVE
Print English CONTR MIX # PMCO001PV CLASS PV
Report RESP 91 DISTRICT 1 LAB PP___ Producer Plant Site REVIEWED BY:
View metric BATCH H20% FINE % @ MORTAR {TYPE} {GAL/CWT} {ABS. VOL}
Report CUYD ADX RED MOD AR VOIDS  CEMENT _ FACTOR _ ASH FA FA CA CAB FAA
T [ 100 [ w [ 6.0 [ 66 | .37 | 5.35 [ 083 | ¢ | B ]| 6530 | 000 | 04315 02630 |
Repert
%MOIST / [LBS / CU YD] [KG/ CU M]
MATERIAL PROD NO PROD NAME SPG % BLEND REPL 55D ADJ ADJ
Design 027FA01 54321-01 LITTLE ROCKS CO. 2.660 100.0 0.00 1178 1178 700
Information 020CA07 1234505 BIG ROCK CO 2.680 100.0 0.00 1947 1947 1156
Design
Variables
Aggregate
Information 37601 3.150 75.0 1.00 405 405 240
— 37801 555-05 CITY ELECTRIC CO. 2.610 25.0 1.00 135 135 80
Finely Divided
Minerals &
Admixtures
ADJ H20 (gal Ibs)] 269 224 133
{FA + CA} MIX-H20 W/C RATIO TOTAL BATCH WT (Ibs) 3880 2309
TOTAL CEMENTITIOUS MATL: THEO. H20 (gal - bs)[_ 269 | 224 |
PRODUCER: __ 1234-05 PROD NAME: EVERYMAN REDI-MIX CO.
REMARKS: ASR Mix Option 2, 25% fiy ash CONTRACT
REMARKS
ADDITIONAL INFORMATION: Lab- PAVE MASTERS CO Location: CHICAGO Target
Matl Designer: SMITH Created Slump (in.) 1.5
Adx(s) Code | Type |Product Remarks
42000 | AEA |AIRPLUS X Designer Phone: 555-555-5555
43000 A |WATER REDUCTO 2000 Designer email: jsmith@email.com
Printed
Ce: ENOCKSON 12/6/2013
METRIC UNITS DESIGN REPORT
DTT03710 PCC MIX DESIGN Version 2.4
IDOT MIX # Not Assigned MATERIAL: __ 21605M _ CONCRETE PC FLYASH EFFECTIVE
—— CONTR MIX # PMCOD01PV CLASS PV
Report RESP 91 DISTRICT 1 LAB PP Producer Plant Site REVIEWED BY
View English BATCH H20% FINE % @ MORTAR {TYPE} {L/KG} {ABS. VOL}
Report CUM ADX RED MOD _AIR _ VOIDS _ CEMENT _ FACTOR _ ASH FA FA CA CAB FAA
o 100 [ W [ 6.0 66 | .37 | 320 [ 083 | ¢ | B ] 04420 [ 0.0000 | 04315 | 02630 |
Report
%MOIST / [KG/ CUM] [LBS / CU YD]
MATERIAL PROD NO PROD NAME SPG % BLEND REPL sSD ADJ ADJ
Design 027FAMO1 54321-01 LITTLE ROCKS CO 2.660 100.0 0.00 700 700 1178
Information 020CAMO7 1234505 BIG ROCK CO 2.680 100.0 0.00 1156 1156 1947
Design
Variables
Aggregate
Information 37601M 3.150 75.0 1.00 240 240 405
37801M 555-05 CITY ELECTRIC CO. 2.610 25.0 1.00 80 30 135
Finely Divided
Minerals &
Admixtures
ADJ. H20 (L - kg)|__133.0 133 224
{FA + CA} MIX-H20: WIC RATIO TOTAL BATCH WT (kg) 2300 3890
TOTAL CEMENTITIOUS MATL:[ 320 | THEQ. H20 (kg - Ibs)[_1330 | 224 |
PRODUCER: _ 1234-05 PROD NAME: EVERYMAN REDI-MIX CO.
REMARKS: ASR Mix Option 2, 25% fiy ash CONTRACT
REMARKS:
ADDITIONAL INFORMATION: Lab- PAVE MASTERS CO Location: CHICAGO Target
Matl Designer: SMITH Created Slump (mm)  38.1
Adx(s) Code | Type |Product Remarks
42000 | AEA |AIRPLUS X Designer Phone: 555-555-5555
43000 A |WATER REDUCTO 2000 Designer email: jsmith@email.com
Printed
Ce: ENOCKSON 12/6/2013
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PCC MIX DESIGN SOFTWARE TUTORIAL Version 2.4
MISTIC DESIGN REPORT
PCC DESIGN MIX
DATE

PCC MIX #: I:l MATERIAL: 21605M EFFECT: (mmddyy)

Print MISTIC REF DESIGN #: PMCO001PV CLASS: PV LAST YR USED: TERM:

Renor RESP: 91  DISTRICT 1 LAB: PP REVIEWED EY: DFLAG:

MIX PROD: 1234-05 EVERYMAN REDI-MIX CO. CONTRACT :

View English BATCH H20%  FINE 3 (2) MORTAR {TYPE} {H20 L/kq} {ABS. VOL}
Report CU m ADX RED MOD AIR  VOIDS CEMENT FACTOR ASH FA FA ca CA,B  FA,B
View metric 1.0 w 6.0 6.5 .37 320 0.83 C B 0.4420 0.0000 0.4315 0.2630

Report $BLEND/ SMOIST (kg / CU m}  LBS/
MATERIAL PROD NO PROD NAME SP G Z RATIO REPL SsD ADJ CU YD
027FAMO1 54321-01 LITTLE ROCKS CO. 2.660 100.0 0.00 700 700 1178
Design 020CAMO7 12345-05 BIG ROCK CO. 2.680 100.0 0.00 1156 1156 1947
Information
Design
Variables 37801M 555-05 CITY ELECTRIC CO. 2.610  25.0 1.00 80 80 135
37601M 3.150 75.0 1.00 240 240 405
Aggregate (ca + 7B} (RATTOS} ADJ H20 (kq:LBS) 133 224
Information
MIX-H20: 0.4420 ASH/CMT WT: 33.3 TOTAL BATCH WT (kg:LBS) 2309 3890
Finely Divided RED MIX H20: 0.4155
Minerals & TOTAL CEMENTITIOUS MATL: 320 THEO. WATER (kg:LBS) 133 224
Admixtures REMARKS: ASR Mix Option 2, 25% fly ash THEQ H20 (GAL) 26.9
REMARKS ! ADJ H20 (GAL)  26.9
Cc: ENOCKSON Designed By: SMITH Phone: 555-555-5555 W/C Ratio: 0.42
email: jsmith@email.com

Note: The MISTIC Report has three input fields to be completed upon receiving approval from the District.

Additionally, there is a tab for help determining the percent water adjustment taking into account various factors.
However, this table is for informational purposes only. The water adjustment calculated using this table is not
referenced by any of the spreadsheet’'s mix design calculations. To use the water adjustment calculated using
this table, the value must be entered on the Design Variable tab.

FIT TO SCREEN \

There are many factors that can be taken into account when determining a mix's water requirement. The table
below allows you to estimate the percentage of water adjustment (typically a reduction) based on the mix's

Design

Return to

Variables

constituent materials. IMPORTANT: This table is for informational purposes only. The water adjustment
calculated here is not referenced by any mix design calculations. To use the water adjustment calculated here, it

must be entered on the Design Variables tab.

= Suggested Adjustment
Water Adjustment | Range | Percentage
Aggregate shape and texture: (Note 1) Note 1: It is recommended to adjust
Baseline (cubical crushed stone) (0%) for aggregate shape and texture as
Rounded. smooth (-5 10 0%) described in Section 2.5.1.2%
"Coarse Aggregate Water
Flat, elongated, rough (0 to +5%) Requirement” and Section 2.5.1.3*
Combined aggregate grading: "Basic Water Requirement.”
Well-graded (-10 10 0%)
Gap—graded‘ (0 to +10%) ‘
Admixture(s):
Alr entraining admixture 1 to 3% air content (0%)
Minimum air content specified: 4 to 5% air content (-5%)
6 to 10% air content (-10%)
MNormal water-reducing admixture (-10 to -5%) Note 2: A polycarboxylate
Mid-range water-reducing admixture (-15 to -8%) superplasticizer may reduce the
High range water-reducing admixture (Note 2) (-30 to -12%) water content up to 40%.
Finely Divided Minerals:
Fly Ash (Note 3) (-10 to 0%) Note 3: For each 10% of fly ash, it
Microsilica (0 to +15%) is recommended to allow a water
High-Reactivity Metakaolin (HRM) (510 +5%) reduction of at least 3%.
Ground Granulated Blast Furnace (GGBF) Slag (0%)
Other factors:
Coarse cement, waier/cement ratio > 0.45, and (1010 0%)
concrete temperature < 60 °F (27 °C)
Fine cement, water/cement ratio < 0.40, and (010 +10%)
concrete temperature = 80 °F (27 °C)
Cumulative Adjustment (%) 0
Reference: Table 2.5.2 "Adjustment to Basic Water Requirement” 0%
* PCC Level lll Technician Course Manual
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PCC MIX DESIGN SOFTWARE TUTORIAL Version 2.4

Changing Macro Security Settings in Microsoft Excel

Note: Any macro settings changes you make in Excel apply only to Excel and do not affect any
other Office program.

To change the macro security settings in Excel 2007/2010:
Coid 9 & 3G

£ E%
. Home Insert Page Layout Formulas Data Review View Developer

= .ﬂ Record Macro -
—2 [[g Use Relative References _}\“ == o View Code

%F Properties == . Map Properties . S import aﬁ

e
()
M

- fa.'_}; Expansion Packs ) Export
Wisual Macrog - Insert Design Source: o, Drocument
Basic i'-.. Macro Security - Mode 2 Run Dialog § Refresh Data Panel

el vy e el i s J VI
1. On the Developer tab*, in the Code group, click Macro Security.

In the Macro Settings category, under Macro Settings, click the 2" option to Disable all
macros with notification.

This option initially disables macros, but alerts you if macros are present. This way, you can
choose when to enable the macros on a case by case basis.

3. Now, close Excel, and re-open the PCC Mix Design spreadsheet.

You should now get a Security Warning (below), click the Options button, then click to Enable
this content, and finally click OK to close the window.

Office 2007 Office 2010

Home Insert Page Layout Formulas

Data

)
m
=

Home Insert Page Layout Formulas

- = & Cut =

= Cut o - . - - .
J " (Arial '[ll A« . Arial 2 ~KX W E =2
F'. ; 43 Copy = = r“ _ 43 Copy - = aaiE
aste - RS B - Past o | e | Jme - = 3
v J Farmat Painter B I U == he? A ¥ J Format Painter B Il 22 R E =3
sboard = | Font & | Clipboard ¥ Fant
= _!, Security Warning  Macros have been disabled, Enable Content
t‘;‘ Security Warning Macros have been disabled. Options... 1

* |f the Developer tab is not displayed...

For Excel 2007: ) For Excel 2010:

1. Click the Microsoft Office Buttc. " 2 1. Click the File tab, click Options, and then
2. Click Excel Options (bottom right corner) click the Customize Ribbon category.

: 2. In the Main Tabs list, check the
3. Inthe Popular category, under Top options '
for working with Excel, click Show Developer, and then click OK.
Developer tab in the Ribbon. 3. Click any other tab to return to your file.
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PCC MIX DESIGN SOFTWARE TUTORIAL

Version 2.4

Changing Macro Security Settings in Microsoft Excel

(continued)

Older versions of Excel:

1. To access the macro security settings in older version of Excel, go to the Tools menu, Options,
Security tab, and click on the Macro Security button. The Security window will open as

shown:

Security

Security Level | Trusted Publishers

() Yery High, Only macros installed in trusted locations will be allowed
bo rurs, All ather signed and wnsigned macros are deabled.

run LhSII;ﬂEd macros are automatically disabled.

) Medium. You can choose whether or nok o run puterktall:.r unsafe
T

) Low {not recommended). You are not protected from potentisly
unsahe macros. Use this setting only if vou have virus scanning
software installed, or you have checked the safety of all documents
YOU e,

[ Ok, |[ Cancel ]

2. Click on Medium, then click OK, and close Excel.

Re-open the PCC Mix Design spreadsheet. At Medium, whenever you open a file that has
macros, a Security Warning (below) appears: click Enable Macros. The file opens and is a
trusted document.

Security Warning @

“C i WritingyMicr osoftExcelYBATONExchangeRates. xls" conkains macros,

Macras may conkain viruses. It is usually safe to disable macros, but if the
macros are kegitimate, you might lose some funckionsity,

E___Dls.el:ulu Macros J | Enable Macros ] | More Info
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